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2. General review of the software 

2.1. What is the program used for? 

The task of the NCT servo amplifiers is to achieve the appropriate speed control for the basic signal, for 

the synchronous and asynchronous motors. This control is achieved in a digital way with the help of a 

high speed target processor (DSP, Digital Signal Processor). This ensures the accuracy, stability and 

reliability of the achieved control. The connection between the drive and the computer is attained an a 

standard serial RS232 serial port. The program is for the installation of the NCT’ synchronous servo and 

asynchronous drives. It is serviceable for the parameter adjustment of the drives during operation, and 

to examine the behaviour of them. The program can be used in On-line and Off-line mode too. In On-

line mode it is capable to the real-time adjustments of the drives. That means during the changes of 

certain parameters we can examine how the drive behaves when it is affected by a certain parameter 

change. Certain elements of the control-loop can be adjusted by sliders which makes the parameter 

variation easier. The program is conformable, it is a well-arranged user-friendly software. 

2.2. System requirements 

• IBM PC compatible computer (The recommended configuration is Pentium or faster) 

• Microsoft Windows 95/98/ME/NT4.0/2000/XP 

• RS232 serial port 

• At least 3MB free space on the hard disk 

• Mouse with minimum 2 buttons 

• VGA monitor with minimum 640x480 resolution 



3. The software installation, uninstallation and setup 

3.1. Software installation 

The parameter adjusting software can installed by the running of SETUP.EXE. After the start of the 

installer follow the commands. The target folder can be given where the program will be installed in, 

and then we can set under what catchword can we find our program in the Start menu. After all these 

the installer will do the necessary job.  

3.2. Software uninstallation  

The software can be removed in a way that we click 

on the Control Panel and in Add or Remove 

Programs menu we have the chance to remove the 

software. 

 

 

 

 

 

 

 

 

 

 

3.3. Correct settings of the parameter variation software  

After all this running the program the 

communication channels should be set, through 

these the software connects to the drive. 

 

 

 

 

Here we can set through which serial channel 

and what speed will we be able to communicate. 

The Baud rate in actual drives should be set 9600bps. The serial communication port (COM port) 

should be set on a free serial port in the computer. The serial port can be set from COM1 till COM4. In 

case of the use of the set serial port it cannot be opened by the parameter variation software, and the 

user is also informed.  When pressing Cancel the setting won’t be accepted and the old settings will 

apply. When pressing OK the settings will be accepted, but they only be executed when exiting the 



program.  When pressing Save button the setting will be 

executed immediately and the next start these will be in 

existence. The setting is successful if after pressing OK or Save 

the program doesn’t send error message, and a drive in operation 

is connected to the computer. It is indicated by the disappearance 

of the animation and the red text from the left corner of the main 

window and it is also indicated by the pipe next to the 

Connection title. After the successful connection the program 

loads the parameters of the drive. The other parameters can be 

set only after switching on the service option. The review of the 

latter is mentioned later.  

 



4. The use of the software 

4.1. General information about the parameter table 

There are two parameter tables in each NCT 

drive. The two parameter tables can store two 

different settings which can be chosen with the 

help of 24 volts signal switched on the input of 

the drive. If there is no such input then the 1st 

table will be the active one. In case of Parameter 

table changing (for example from parameter table 

to two) the drive after a short reset will use the 

Parameter table suitable for the input signal. 

Parameter table changing is only possible in “not 

allowed” state of the drive. The parameter 

variation software writes the number of the 

active Parameter table in the left corner of the 

main window.  The colour of the title, in case of 

the first parameter table, is light green and in 

case of the second Parameter table it is light blue. 

This draws our attention to the fact that the 

colour of the editing table, in the middle of the 

main window, should be the same as the colour of the active parameter table’s title. Because the two 

Parameter table can be edited separately. Not only the active table can be edited but the inactive too. 

The difference is that the changes in the active Parameter table will be executed immediately, but these 

changes become lost as the supply voltage of the drive is switched off.  Not to lose these parameters 

the table should be loaded into the drive. 

There are parameters which are protected and as a result of this they cannot be easily edited. This 

protection protects the drive as the changing of these parameters can cause error. These parameters can 

be changed only by the use of the password. The password can be written in the Settings/Preference… 

pop-up window after the pressing of the Enable Service Functions button. Then a password window 

appears. Typing the password and pressing OK the program lets you now whether it is accepted or not. 

If it is accepted, after closing the window in the right bottom corner of the main window the Protect 

function field will become active, where the protection can be switched on/off. If the protection is 

switched off these parameters will behave in the same way as the others. The Protect function field 

becomes inactive if the parameters are downloaded or the program is restarted. In case of the necessity 

of the activating password the user should contact the manufacturer.  



4.2. Operations with parameter tables  

4.2.1. Make a new parameter table 

A new parameter table can be created by 

choosing New in the File menu or by 

pressing CTRL + N key sequence.  

 

 

 

In the window which appears a definition 

table suitable for the type of the drive should be given. If a drive is sensed on the input then only 

the definition table which is suitable for 

the type of the drive can be loaded and 

that name is in the drive. At loading the 

program interrogates this name from the 

drive and if the two names are not the 

same a message is sent to the user that 

this definition table cannot be changed. 

The parameters can be loaded into the 

drive only according to the definition table which is connected to the version number of the drive. 

This definition table cannot be changed in the drive. In the data definition file editing is not 

allowed. 

If the DFT file is successfully loaded then a window appears in which parameters can be edited 

according to parameter groups. The 

parameters are divided into different a 

functional groups which will be 

discussed later. It is the table in which 

the parameters can be filled. At the 

opening of the window the minimum 

values of the parameters will be stated 

in the tables. After the appropriate 

changes of the parameters they can be 

made valid by pressing Accept and 

these values will go into both parameter tables. The new parameters will be valid only after 

loading. 



4.2.2. Editing of the  parameter table 

The editing of the parameter table can be carried out in the main window of the program or in the 

window which comes up by clicking on 

Edit/Blockedit… and  which is very similar 

to the window used at the creation of the 

new parameter table. While editing in the 

main window we can choose one from the 

two tables which we like to edit, this can be 

done with the tabs. The first table is light 

green and the second one is light blue. The 

blue or green title in the right bottom part 

of the window indicates which parameter 

table is active in the drive. While editing in 

the active table the edited parameter is 

executed immediately if we press Enter or 

move the mouse or the cursor from the 

edited parameter. Afterwards the drive will 

operate with the new parameter. The 

changes in the inactive table will have no 

impact on the drive as long as the hole 

parameter table (first and second one) is not downloaded into the drive. If the active parameter 

table has changed in the drive during editing then we will be informed about this event when the 

drive make an autopolling at the time of the parameter editing. In this case the changed parameter 

won’t be downloaded into the drive. 

During editing two important messages can be 

received from the program. The firs message is 

created when we attempt to edit protected 

parameter. Then a pop-up window warns us that 

this parameter is protected and its value cannot be changed. These parameters can be changed 

only by switching off the protective function.   

The other message is created if the value written by us is 

not in the latent range of the parameter. Then the pop-up 

window informs us about the parameter which can be 

seen in he header, and its minimum/maximum value and 

the incorrect value written by us.     The window cannot 

be closed unless we write in the correct value.  After 

giving the correct value and pressing OK we can continue 

with editing. 



The editing can also be done in the 

above mentioned Blockedit window. 

The values of the table which is 

chosen for editing  will go to this 

window. The background of the tables 

in the window will be the same as the 

background colour of the table 

marked for editing in the main 

window. Here we can edit the 

parameters according to groups. The 

groups can be chosen by the tabs on the top of the window. As the editing is finished pressing the 

Accept button the modified values will be written in the table of the main window. If the active 

parameter table was edited in this window then it would be executed after pressing Accept. When 

pressing Cancel the modifications will become lost. The two pop-up windows mentioned before 

are also valid in this case, if we edit a protected parameter or the value written in is not in the 

latent range.      

An automatic error correction is operating in both edit windows which does not allowed that 

incorrect characters will be typed in the given filed.  The incorrect characters are disregarded by 

editor and only the valuable characters will be considered. 



4.2.3. Load of parameter table from file and save it to file 

4.2.3.1. Load parameter table 

Parameter table can be loaded by clicking on Open in the File menu. Then the window 

above appears. It is this window in which we can chose the file that should be loaded.  

When choosing the file in the dialog box at the bottom part of the window the information 

connected to the file appears which is a short review regarding the parameter tables in the 

file.  We are unable to write in this field.  

Three types of file types can be chosen. The first type is the .sps, which contains the 

parameter table connected to asynchronous drives in default. The second one is the .ses 

which contains the tables connected to synchronous drives. The third one is .spf which is a 

simple parameter table file. This type can store a parameter table connected to any kind of 

drives. It is stored in the file which drive the stored table is connected to. 

In the parameter file it is stored that which data 

definition table is connected to it. When we load a 

parameter table the definition file connected to it is 

automatically loaded before. That does not cause a 

problem as long as the program does not sense an On-line drive. If the program senses On-

line drive it compares the definition tables stored in the parameter file in the drive. If the 

two of them are the same then the parameter table is loaded. If they are different then the 

program sends a message that the given operation cannot be executed.  

A parameter table can only be loaded if the definition file connected to the parameter file 

exists and the program can reach it. If a file like this does 

not exist then the given parameter list file cannot be 

loaded by the program. In this case one should contact 

the manufacturer. The dialog box offers the possibility to 

exit the program or continue working. 



If the program has loaded the 

parameter table from the file then 

it warns us after the load that 

other parameters can be found in 

the drive and asks whether we 

want to load the table into the 

drive to use these parameters by 

the drive. If we click on Yes then a parameter load will be executed and the parameters in 

the drive and the table will be the same after the load. If we click on No the two parameter 

tables will be different. In this case the changes on the active parameters can results in 

extraordinary effects in the system. So it is not suggested to tamper with the active 

parameter table. If we do this we should do it carefully or switch off the drive before. 



4.2.3.2. Save parameter table 

Parameter table can be saved by choosing Save/Save as… in the File menu. Save will save 

with the same filename as long as we ask for a parameter upload or we make a new 

parameter table. If we did all this the Save command will behave in the same way as the 

Save as… command.  

By clicking on Save as… we get a window similar to the one which we get clicking on 

Open. The difference is that the header has different title and bottom text box can be 

written. In this box we can type a text of any length regarding the drive and the motor. If 

we want to save our data on an existing parameter file then clicking on it the informational 

text connected to it is loaded which can also be edited.  

Clicking on Save the parameter file and the informational file connected to it is created.  

4.2.3.3. File manager buttons 

In dialog windows which come up at the saving or loading parameters these buttons can be 

seen. The function of the buttons from left to right:  

• Move back to the previously used folder. While changing the folders the last ten 

folders are stored. As an effect of the pressing of the button we can go back to the 

folders as long as the button does not become grey.  

• Move back in the folder structure to a folder which is up one level. By pressing the 

button we can move back to the root folder.. 

• Creation of the new folder. In the marked folder we can create a new folder. In the 

pop-up window we can give the name of the new folder and by clicking OK the folder 

is created. As the folder is created it becomes the folder in which we can save new 

data. If there is an error during the creation of the folder then the program will inform 

us.  

• Copy of file. This button is active only if any of the files are marked. When we pressed 

the button the dialog window of the picture underneath appears in which we can give 

the target folder where we want to copy the marks file and we can give a new name to 

the target file. Pressing the Copy button a copy is made from the file to the given 

place.  



• Moving of the file. The button is only active if we have already marked a file. When 

pressing the button a dialog window similar to the previous one comes up. After given 

the target data pressing the move button the file will be moved to the marked place. 

• Searching of the file. The window underneath appears as we press the button. We can 

give the file name which is searched in which the ? and * characters are allowed. We 

can give the drive and the folder where we want to search. The search starts as we 

press Search. It lists the files and the folders which are found. If w choose a file from 

the list and click on Go to… button then in the Open or Save window the found file 

will be marked on which we can execute operations.  

• Help. 



4.2.4.  The burn of the parameter table and its upload from the drive 

4.2.4.1. Burn of the parameter table into the drive 

The finalization of the parameter can be done by clicking on the Download parameters… 

button or by clicking on Parameter download in the Loader menu. Then a message window 

pops up which asks whether the operation should be done. As the Yes button is pressed the 

process needed for parameter burn, is started. 

First the programme carries out a checking on the parameter table not to have incorrect 

data in the drive. It checks the latent range of certain drives and if something different is 

found it warns the user about the incorrect parameters. In the pop up window the correct 

value should be given.  The programme will not continue running until we give an 

acceptable value. 

If the checking is finished a message will be sent to the user about the parameters which 

will not change.  It will be executed if the parameter protection is not switched off. 

After all this starts the burn of the parameters into the memory of the drive. If the burning 

process is successfully done the programme will run a checking operation as well. This 

operation compares the burnt parameter table to the original table and if they are the same a 

message is received about the success of the burn.  

In case of any errors the user will get a message about the unsuccessful operation. In this 

case the burning operation should be repeated as long as it succeeds. 

4.2.4.2. Upload of parameter table from the drive 

The upload of the parameters can be done by clicking on the Upload parameters button or 

by clicking on Parameter upload in the Loader menu. While uploading, the parameter table 

of the drive appears in the table of the program’s main window, where we can edit the 

parameters later on.  

4.2.5. Printing of parameter tables 

It is possible by clicking on Print… in the File menu. As a result both parameter tables will be 

printed next to each other, together with parameter names. 



4.2.6. Copy of parameter tables 

We have the chance of copying between parameter table one and parameter table two.  The Copy 

PAR1 to PAR2 and Copy PAR2 to PAR1 will activate this function in the Edit menu. Logically 

the first point will copy the content of parameter table one into parameter table two, the second 

point is the same but the other way around. If the inactive parameter table is copied into the active 

parameter table then the changes in the active parameter table will be executed in the drive 

immediately. 

4.2.7. Comparison of parameter tables 

We have the possibility to check whether the values of the first and the second parameter tables 

are the same. It can be done by choosing PAR1 and PAR2 in the Edit menu.  The differences 

between the two parameter tables is listed by the programme, the  identure number of the 

parameters in the table is present that value is different. 

4.2.8. Switch off the protective function 

There are some parameters in servo amplifiers which can be adjusted next to advanced 

inspection, before modifying these values please contact the manufacturer. If these parameters are 

adjusted in a wrong way then the servo system (motor and amplifier) will not operate properly or 

it can brake down. Because of this these parameters are protected in order not to disadjust them 

by any chance. The protection can be switched off by a password. The password for authorized 

persons should be given by the manufacturer. 

The password can be activated in a password window by clicking on Enable service functions 

button in the Settings/Preference menu. After activating password there are many other 

possibilities for adjustment. The protection can be switched off by using the buttons in the right 

bottom corner of the main window. As long as the password is inactive these buttons will not 

work. The password is active as long as we do not log off, or do not burn the parameter table into 

the drive. Afterwards the password can be written again if it is needed. 

The password is not for encryption, but  it protects the servo system from break down. The 

protected parameters should be used for own liability. 



4.3. Drive diagnostics 

4.3.1. Display of the drive state 

This operation displays the error register, 

and the status register of the drive, and 

indication of the information regarding the 

motor in real-time is possible by it. The 

real-time query can be switched on and off 

by clicking on the button in the right 

bottom part of the window. The parametric 

variation window can be opened by the 

button in the left bottom part where with 

the help of the sliders the control-loop 

elements of the drive can be adjusted. The 

drive will respond to these immediately, 

thus a reel-time parameter adjustment can be 

executed. The background colour of this 

window is always the same as the active 

parameter table in the main window. In the 

window the adjustment of a parameter can be 

done by the slider or we can type the new 

values in to the txt field next to the slider 

which can be activated by pressing Enter. 

The real-time parametric variation window is 

in close relation with the table of the main window. The changes which are present here are also 

appear in the main window table. At the same time if we change one of the parameters of the 

control-loop in the parameter table in the main window and the changes in the active parameter 

table the change will appear immediately in the real-time parametric variation window. 



4.3.2. The scan of the drive’s memory register 

Besides the motor operation information, drive 

state- and error register written in the previous 

chapter many other data can be monitored in 

the drive if the values of the memory registers 

are interrogated.   Units are not connected 

directly to these values. A new memory scan 

window can be opened by clicking on New 

memory scan window… in the Diagnostic 

menu of the main window  or by pressing F3 function key. More windows can be opened parallel 

with each other in which differently addressed memory registers can be interrogated.  In certain 

memory interrogating windows the memory addresses determined by the manufacturer can be 

loaded by clicking on Fix registers in the Load menu , or we can type the address of the memory 

register into the left hand side text field on the Scanning memory… panel. If the address is given, 

by clicking on the markable Scanning box the continuous memory scan starts. The received data 

is the value of the 16bit memory register on the given memory address. The displaying mode can 

be changed on the Scanmode panel into hexadecimal or decimal.  



4.3.3. Use of oscilloscope 

By the oscilloscope the events in the servo amplifiers during operation can be shown in graphic 

style. The inner registers of the servo amplifier can be shown, which is done in a way that in case 

of receiving the processor in the drive records the data of two channels. It takes 4000 samples 

then these will be sent through the serial port. The upload starts at the moment of recording. The 

oscilloscope will show these 4000 samples in two channels. 

 
It can be chosen whether the sample taking would be cyclical (125microsecond) or  it would be 1 

millisecond. The address of the examined register should be given in hexadecimal (Addr). After 

pressing start the upload and the visualization of the 4000 samples begins.  We can regulate the 

visualisation with the help of the Gain and Offset parameters if it is needed. After the overwriting 

of the two parameters and pressing Enter the re-drawing of the channel will be executed. The 

reaction of the oscilloscope to the left or right button of the mouse can be chosen. Two types of 

drawing mode can also be chosen which are the drawing of the points or the drawing by lines.   

By switching on the Smooth function the noise functions can be smoothed. The degree of the 

smooth is determined by the Smooth sen. Parameter. The fixed functions can be saved in the file 

and can be loaded from there. 



4.3.4. Ask for drive information 

Program and version information about the drive can be 

asked by clicking on Drive information in the Diagnostic 

menu of the main window or by pressing Ctrl-I. The type of 

the definition table, the software version and serial number of 

the drive, the burning time of the program which operates the 

drive and the last time when the parameter table was 

modified appears here.  
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